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LLS(Linux License Server) CLS(Cloud License Server)
서버 위치 Linux 설치 PC Arm 클라우드 서버

특징

서버를 관리하고 유지하기 위한 인프라 필요
단일 서버에서 라이선스 관리
사용량 진단 가능
인트라넷 가능

내부 인프라 필요 없음
Arm 라이선스 관리 페이지 활성화 코드 관리
사용량 진단 불가능
인트라넷 불가능

사용 방법

서버
특정 Linux 버전 서버에서 라이선스 생성
Red Hat Enterprise Linux / CentOS 7 and 8
Ubuntu 20.04 LTS

Arm 라이선스 관리 페이지에서 활성화 코드 생성

클라이언트 서버 주소 연결 후 라이선스 등록 관리자가 생성한 활성화 코드 등록

네트워크
요구 환경

서버와 클라이언트가 동일 네트워크에 위치 필요
또는 VPN을 이용한 접근 필요

인터넷이 연결되어 있으면 언제 어디서나 접근 가능

제안 환경 다수의 개발자 환경에 적합 소수의 개발자 환경에 적합

수명 주기
클라이언트에서 라이선스 첫 접근 후, 7일동안 사용 가능
라이선스 사용마다 LLS 또는 CLS URL에 연결하여 캐시된 라이선스 갱신 시도(24시간마다 1번 시도)
7일 동안 갱신하지 못할 경우 라이선스 무효화

최소 지원 버전

Arm Compiler for Embedded 6.18
Arm Compiler for Embedded FuSa 6.16.2
Arm Development Studio 2022.0
Keil MDK 5.37
Arm Fast Models 11.17.1



UBL은 사용 권한을 획득 한 후 7일의 생명주기를 가지고 있습니다.

Arm tool을 사용할 때 사용한 날로부터 생명주기 7일을 더 연장합니다.

관리자는 권한을 부여된 라이선스를 Revoke하여 사용자의 라이선스 생명주기 연장을 억제할 수 있습니다.

관리자는 회수가 필요한 라이선스를 Revoke를 해도 즉시 라이선스가 관리자에게 반환되지 않습니다.

생명주기가 종료되어야 라이선스가 관리자에게 반환됩니다.

Revoke된 라이선스 사용자는 남은 생명주기 시간동안 라이선스를 사용할 수 있습니다

2가지 방법 중 하나를 사용하여 라이선스 사용 권한을 얻을 수 있습니다.

리눅스 라이선스 서버 포트와 아이피 접근(LLS 방식), 인트라넷(사내) 네트워크 환경에서 사용 가능

활성화 코드 입력(CLS 방식), 인터넷 네트워크에서 사용 가능

UBL(User Based License) 개요
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날짜 행동 만료일

5월 10일 라이선스 권한 획득 5월 16일

5월 13일 Arm 컴파일러 빌드 5월 19일

5월 19일 14~19일 휴가 사용 종료

날짜 행동 만료일

8월 1일 라이선스 권한 획득 8월 7일

8월 7일 Arm 디버거 사용 8월 13일

8월 20일 Arm 컴파일러 빌드 사용 불가, 권한 획득 필요



User Based License는 1유저 1라이선스가 원칙입니다.

본 메뉴얼의 방법으로 라이선스를 사용하면 1유저 1라이선스 원칙에 위배되지 않습니다.

비정상적인 방법으로 1라이선스로 2명 이상의 유저가 동시에 사용할 시 Arm 라이선스 약관 위반입니다.

Arm End User License Agreement(EULA) 보기

Arm 라이선스 약관 위반 시 저작권법을 위반한 것으로 아래의 법적 책임이 발생할 수 있습니다.

제136조(벌칙)에 의거하여 5년 이하의 징역 또는 5천만원 이하의 벌금이 부과될 수 있음

제141조(양벌규정)에 의거하여 법인 또는 개인에게도 벌금이 부과될 수 있음

불법 소프트웨어 근절, 정직한 사회를 만들어가는데 MDS테크가 함께 하겠습니다.

주의사항
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https://developer.arm.com/downloads/-/arm-instruction-emulator/eula


라이선스 PDF 파일 확인
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Product Code

CLI 환경으로 Arm tool을 사용하기 위한 라

이선스를 등록하기 위해 필요

Serial Number

Arm 계정에 라이선스를 등록하기 위해 필요

라이선스 발주 후 받은 PDF 파일을 확인합니다.



CLS(Cloud license server)
설치 가이드



(서버)Cloud License Server 환경 셋업 가이드
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Arm UBL 라이선스 관리페이지로 이동 및 로그인합니다.

https://developer.arm.com/support/licensing/user-based/products

지속적인 라이선스 관리 ID 로그인 필요

담당자가 퇴사하더라도 인수인계가 가능한 ID 제안

Products 탭에서 Add a product를 클릭합니다.

전 페이지에서 받은 시리얼 넘버를 입력 후 Redeem 버튼을 클릭합니다.

라이선스가 추가된 것을 확인하고 클릭합니다.

Product Code가 표시되는 것을 확인 가능

https://developer.arm.com/support/licensing/user-based/products


(서버)Cloud License Server 환경 셋업 가이드

9

우측 Generate activation code를 클릭합니다.

Generate code는 구매한 라이선스 Seat 수만큼 가능

Table에 생성된 Activation code가 표시됩니다.

Activation code는 7일동안 사용 가능하며 등록된 PC의 전원이 켜져 있으면 사용 기간 7일 자동 갱신

사용 기간이 만료되면 서버에 등록된 Activation code가 사라짐

Activation code는 8자리-4자리-4자리-4자리-12자리로 구성



(클라이언트)Cloud License Server 환경 셋업 가이드
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Keil MDK의 경우

File > License Management > User-Based License > Activate/Deactivate 클릭

Arm Development Studio의 경우

Window > Preferences > Arm DS > Product Licenses > Manage Arm User-Based Licenses 클릭

전 페이지에서 생성한 Activation Code를 입력 후 Activate를 클릭하여 라이선스 등록을 마무리합니다.
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컴파일러 Standalone 방식의 경우 컴파일러 설치 폴더 > bin 폴더로 이동합니다.

armlm 실행파일을 확인합니다.

Window의 경우 armlm.exe

Linux의 경우 armlm 이미지

해당 경로에서 터미널을 Open합니다.

컴파일러가 설치된 폴더 안의 bin 폴더에서 터미널 열기

./armlm activate --code <활성화 코드> 명령으로 라이선스 등록을 마무리합니다.

./arm deactivate --code <활성화 코드> 명령으로 라이선스 비활성화 가능



LLS(Linux license server)
설치 가이드



(서버)Linux License Server 환경 셋업 가이드
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LLS는 특정 리눅스 버전에서 설치 가능합니다.

Red Hat Enterprise Linux / CentOS 7 & 8 / Ubuntu 20.04 LTS

리눅스 PC에서 필수 라이브러리를 설치합니다.

sudo apt update

sudo apt install –y openjdk-11-jre-headless python-is-python3

서버 S/W를 다운로드 후 리눅스 PC에 설치합니다.

https://lm.arm.com/downloads 링크에서 flexnetls-armlmd-<version>.tar.gz 파일 다운로드 후 리눅스 PC로 전송

tar –xf flexnetls-armlmd-<version>.tar.gz 명령으로 압축 해제

sudo ./flexnetls-armlmd-<version>/install_license_server 명령으로 리눅스 서버 설치

정상적으로 설치되었으면 다음의 로그가 표시되고 서버 S/W를 자동으로 실행합니다.

https://lm.arm.com/downloads


(서버)Linux License Server 환경 셋업 가이드
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서버 라이선스 S/W의 Default 설치 경로는 /opt/flexnetls-armlmd 입니다.

설치 디렉토리의 bin 폴더를 환경 변수로 지정하여 쉽게 명령을 불러올 수 있습니다.

export PATH=/opt/flexnetls-armlmd/bin:$PATH

영구적으로 환경 변수를 지정하려면 다음 명령 실행

sudo vi ~/.bashrc 명령, 맨 아래줄에 export ARMLM=“opt/flexnetls-armlmd/bin”, export PATH=$PATH:$ARMLM 2줄 추가

저장 후 source ~/.bashrc 명령

아래 명령을 실행하여 Arm 라이선스 서버 비밀번호를 변경합니다.

armlm_change_admin_password

비밀번호는 대소문자, 숫자, 특수문자가 포함되어야 함

비밀번호는 로컬에만 지정. 비밀번호를 잊어버렸을 경우

라이선스 서버를 다시 설치해야 하므로 주의할 것

성공적으로 변경되었을 경우 다음의 메시지 출력



(서버)Linux License Server 환경 셋업 가이드
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아래 명령을 입력 후, 사용할 호스트 ID와 MAC주소를 기억합니다.

armlm_show_hosted

서버 구성 정보를 수정합니다.

sudo vi /opt/flexnetls-armlmd/server/local-configuration.yaml 명령

사용할 port 번호 수정, default 포트번호는 7070

(선택) active-hostid 주석(#) 해제 후 위에서 기억한 MAC 주소 입력

예시) active-hostid: 445566778899/EHTERNET

변경 사항 확인 후 저장

라이선스 서버를 재 시작하여 변경사항을 저장합니다.

sudo systemctl restart flexnet-armlmd

MAC/Type
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현재 서버 정보를 확인하기 위해 다음의 명령을 입력합니다.

armlm_check_server_status

만약 서버가 실행 중이 아닐 경우, 아래 명령으로 서버 실행

sudo systemctl start flexnetls-armlmd

아래 명령으로 identity 파일을 생성합니다.

armlm_generate_server_identity --identity-file identity.bin

아까 재설정한 arm 라이선스 서버 비밀번호 입력

identity.bin 파일 생성 확인



(서버)Linux License Server 환경 셋업 가이드
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identity.bin 파일을 등록합니다

이 작업은 서버, 클라이언트 등 어느 PC에서 해도 상관 없음

https://developer.arm.com/support/licensing/user-based/servers 페이지 이동 후 Register a server 클릭

Choose or drag & drop your identity file here 클릭

identity.bin 파일 등록 후 Upload file & register server 클릭

Server name은 공란으로 둘 경우, ARM-(랜덤숫자)로 자동 설정

https://developer.arm.com/support/licensing/user-based/servers


(서버)Linux License Server 환경 셋업 가이드
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아래 경로에서 라이선스 서버가 정상적으로 등록되었는지 확인합니다.

https://developer.arm.com/support/licensing/user-based/servers

등록된 서버 버튼을 클릭하여 관리 페이지로 이동합니다.

가장 위에 서버 라이선스 서버의 MAC주소 표시

PRODUCTS에 구매 라이선스 종류 표시

https://developer.arm.com/support/licensing/user-based/servers
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서버에서 사용할 라이선스 Seat 수를 지정합니다.

Default는 0

변경 사항이 있다면 Confirm Changes 버튼 활성화

Confirm Changes 버튼을 눌러 변경 사항을 저장합니다.

변경 사항이 없다면 Confirm Changes 버튼 비활성화

라이선스.bin 파일을 다운로드 합니다.

Manage Server > Download licenses 클릭

다운로드 받은 라이선스.bin파일 서버 PC로 복사

라이선스.bin 파일은 관리 가능한 파일에 저장하는 것이 좋음

라이선스.bin 파일 포맷은 다음과 같습니다.

licenses-<서버 MAC 주소>-<라이선스 생성일>.bin

예시) licenses-C85B76EF1D2E-2024-01-30_02-59-36.bin
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아래 명령으로 라이선스를 등록합니다.

armlm_update_licenses --data-file <라이선스 bin파일>

라이선스 서버 비밀번호 입력

다음 로그가 출력되면 정상적으로 등록된 것입니다.



(클라이언트)Linux License Server 환경 셋업 가이드
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Keil MDK의 경우

File > License Management > User-Based License > Activate/Deactivate 클릭

Arm Development Studio의 경우

Window > Preferences > Arm DS > Product Licenses > Manage Arm User-Based Licenses 클릭

Activate your product > License Server 선택 후 Server 주소를 입력합니다.

http://<아이피 주소>:<포트 번호> 입력 후 Query 버튼 클릭

제품 확인 후 Activate 클릭 후 라이선스 활성화



(클라이언트)Linux License Server 환경 셋업 가이드
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컴파일러 Standalone 방식의 경우 컴파일러 설치 폴더 > bin 폴더로 이동합니다.

armlm 실행파일을 확인합니다.

Window의 경우 armlm.exe

Linux의 경우 armlm 이미지

해당 경로에서 터미널을 Open합니다.

컴파일러가 설치된 폴더 안의 bin 폴더에서 터미널 열기

./armlm activate --server http://<IP주소>:<포트 번호> --product <Product Code> 명령으로 라이선스

등록을 완료합니다.

./armlm deactivate --product (Product Code) 명령으로 라이선스 비활성화 가능

AB123



LLS(Cloud license server)
관리자 가이드



Cloud License Server 라이선스 관리자 가이드
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Arm User Based Lisence 포탈에 로그인 합니다.

활성화된 제품 타일을 클릭합니다.

활성화된 제품이 없고 Add a product만 보일 경우 본 매뉴얼을 참고하여 제품을 추가합니다.

표시된 테이블에서 User는 활성화된 PC의 이름을 표시합니다.

생성된 활성화 코드를 등록한 PC가 없다면 공란으로 표시됩니다.

활성화 코드 우측의 버튼을 클릭하면 2가지 기능을 사용할 수 있습니다.

Copy activation code, 활성화 코드를 PC 클립보드로 복사합니다.

Revoke activation code 활성화 코드를 취소합니다.

Revoke activation code를 클릭하면 아래의 둘 중 하나의 결과를 얻습니다.

활성화 코드 즉시 삭제

활성화 코드를 PC에 등록하지 않은 경우

활성화 코드를 PC에 등록했지만 해당 PC에서 Arm tool을 7일 동안 사용하지 않은 경우

활성화 코드 비활성화

활성화 코드를 PC에 등록했고 해당 PC에서 Arm tool을 7일 동안 사용한 경우

이 경우에 해당 PC에서 Arm tool을 사용해도 생명주기가 갱신되지 않음

활성화 코드가 삭제되면 시트에 개수가 채워지며 다른 사용자에게 활성화 코드를 부여할 수 있습니다.

https://developer.arm.com/support/licensing/user-based


Linux License Server 관리자 가이드
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라이선스 서버를 정지하기 위해 아래 명령을 입력합니다.

sudo systemctl stop flexnetls-armlmd

라이선스 서버를 시작/재시작하기 위해 아래 명령을 입력합니다.

sudo systemctl start flexnetls-armlmd (시작) / sudo systemctl restart flexnetls-armlmd (재시작)

라이선스 서버를 확인하기 위해 아래 명령을 입력합니다.

armlmd_check_server_status

서버에 등록된 라이선스를 확인하기 위해 아래 명령을 입력합니다.

armlm_list_product --show-expired –utc

관리자 비밀번호를 변경하기 위해서 아래 명령을 입력합니다.

armlm_change_admin_password

비밀번호는 아래의 기준을 만족해야 합니다.

8~64자

최소 한 자리 숫자

최소 한 자리 대문자

최소 1개의 특수문자

공백이 없음

비밀번호가 정상적으로 변경되면 다음의 출력을 확인할 수 있습니다.
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현재 라이선스 서버가 실행 중인지 확인하려면 아래 명령을 입력합니다.

armlm_check_server_status

서버가 실행 중이 아니라면 다음 명령을 사용하여 서버를 시작합니다.

sudo systemctl start flexnetls-armlmd

라이선스 서버가 시작되지 않으면 systemctl에서 오류 확인이 가능합니다.

Journalctl -u flexnetls-armlmd.service.b

라이선스와 사용량 체크와 만료된 라이선스를 확인하려면 아래 명령을 입력합니다.

armlm_list_products –show-expired

현재 사용량 리스트를 체크하려면 아래 명령을 입력합니다.

armlm_list_users

Arm 라이선스 포털에서 사용할 수 있는 라이선스 수가 서버에 할당된 활성화 코드 또는 라이선스 수를 초과하는 경우

Arm 라이선스 포털의 제품 타일에 유효 시트보다 활성화 코드나 할당된 좌석이 더 많다는 경고가 표시됩니다.

이 때 새로운 활성화 코드(CLS)나 라이선스 서버(LLS)에 라이선스를 할당할 수 없으므로 초과된 라이선스 수를 감소시켜야 합니다.
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전 라이선스 관리자가 퇴사/부서이동 등으로 라이선스 서버에 엑세스 할 수 없는 경우 아래로 진행합니다.

Arm User Based Lisence 포탈에 로그인합니다.

제품 탭을 클릭하고 Local Server 탭을 클릭하면 라이선스 서버 이름이 Server name 열에 나열됩니다.

해당 화면을 캡처한 후 MDS테크에 연락하십시오.

Arm UBL 관리 포탈에서 사용자가 직접 라이선스가 불가능합니다.

이전 서버를 완전히 폐기하도록 Arm 차원의 작업이 필요합니다.

LLS에서 CLS로 이전하는 등의 사유로 라이선스 서버를 삭제/폐기하고 싶다면 아래로 진행합니다.

아래 명령으로 라이선스 서버를 정지합니다.

sudo systemctl stop flexnetls-armlmd

현재 터미널 경로를 아래의 2가지 경로를 제외한 경로로 변경합니다.

라이선스 서버 설치 Default 경로: /opt/flexnetls-armlmd

데이터 저장 Default 경로: /var/opt/flexnetls-armlmd

아래 명령으로 라이선스 서버를 제거합니다.

sudo <라이선스 서버 설치 경로)/bin/armlm_uninstall_license_server --delete-storage

--delete-storage는 선택 사항입니다. 이 플래그를 삽입하면 할당된 라이선스, 관리자 비밀번호, 서버 구성을 포함한 모든 데이터를 삭제

합니다.

라이선스 서버 삭제 또는 폐기하기 전 사전 검토 바랍니다.

https://developer.arm.com/support/licensing/user-based


FAQ
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클라이언트에서 라이선스 서버 URL을 인식할 수 있는지 확인 할 수 있습니다.

armlm inspect –server <서버 URL> 명령

서버 URL은 http://<IP address>:<Port>로 구성

<Tools 설치 폴더>/bin에 armlm 파일 위치

클라이언트가 서버에 연결할 수 있는 경우 이 명령은 서버에서 사용 가능한 다양한 라이선스를 반환



(리눅스)flexnetls-armlmd-<version>/install_license_server 옵션
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리눅스 PC에서 라이선스 서버를 설치할 때 사용 가능한 옵션은 다음과 같습니다.

sudo [-E] flexnetls-armlmd-<version>/install_license_server [--port <port>] [--install-dir <installation directory>] [--data-dir <data_directory>] [--user 

<user>] [--group <group>]

-E

매개변수는 명령을 루트로 실행할 때 현재 사용자의 환경을 보존합니다. 이는 JVM(Java Virtual Machine)의 위치가 현재 사용자 환경에 설정된 JAVA_HOME 환경 변수에 의존

하는 경우 필요할 수 있습니다.

<port>

라이선스 서버가 수신 대기하는 TCP 네트워크 포트를 지정합니다. --port 매개변수가 지정되지 않은 경우 포트는 기본적으로 7070으로 설정됩니다. 이 포트 범위는 루트로 실

행되는 프로세스용으로 예약되어 있으므로 1024 이하의 포트번호를 지정할 수 없습니다.

<installation_directory>

라이선스 서버 소프트웨어의 설치 디렉토리입니다. -- installation directory 매개변수가 지정되지 않은 경우 설치 디렉터리는 기본적으로 /opt/flexnetls-armlmd로 설정됩니다.

<data_directory>

라이선스 서버 상태 파일 및 로그를 저장하는 데 사용되는 디렉터리입니다. --data-dir 매개변수가 지정되지 않은 경우 데이터 디렉터리의 기본값은 /var/opt/flexnetls/armlmd

입니다.

<user>

라이선스 서버가 실행되는 사용자 이름입니다. --user 매개변수가 지정되지 않은 경우 라이선스 서버는 flexnetls 사용자로 실행됩니다.

<group>

라이선스 서버가 실행되는 그룹 이름입니다. --group 매개변수가 지정되지 않은 경우 라이선스 서버는 flexnetls 그룹으로 실행됩니다.

라이선스 서버는 설치 프로세스가 완료되었을 때 자동 시작되며 서버 PC가 다시 시작될 때 자동으로 시작됩니다.



(리눅스)라이선스 서버 설치 후
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라이선스 서버가 설치되면 자동으로 시작됩니다.

라이선스 서버 서비스는 PC와 함께 자동으로 시작 및 중지되도록 구성됩니다.

설치 디렉토리에는 아래의 파일이 포함됩니다.

bin에는 관리 유틸리티가 포함되어 있습니다.

etc에는 데이터 및 서버 디렉토리에 대한 경로를 자세히 설명하는 경로 텍스트 파일이 포함되어 있습니다.

server에는 라이선스 서버 데몬과 관련 구성 파일이 포함되어 있습니다.

License_terms에는 소프트웨어 라이선스 계약이 포함되어 있습니다.

VERSION 텍스트 파일에는 라이선스 서버 버전이 설명되어 있습니다.

설치 중에 설치 경로를 변경하지 않은 경우 설치 디렉토리의 기본 값은 다음과 같습니다.

/opt/flexnetls-armlmd



라이선스 생명주기
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활성화 후 사용자는 7일 동안 제품 라이선스에 할당됩니다. 

사용자가 UBL을 지원하는 Arm 개발 도구를 7일 이후에 사용하면 활성화 코드 URL 또는 라이선스 서버에 연락하여 다음 7일 동안 라이선

스가 갱신됩니다.

7일 이후에도 사용하지 않을 경우, 서버에서 해당 라이선스 활성화 코드를 Revoke하여 새로운 사용자에게 부여할 수 있습니다.

제품 라이선스를 연장할 수 없는 경우에도 7일 제한이 만료될 때까지 라이선스가 부여된 대로 제품을 사용할 수 있습니다.

이는 장치가 라이선스 서버에 접속할 수 없는 경우 발생할 수 있습니다.

여러 장치에서 라이선스 활성화할 수 있습니다.

사용자에게 할당된 제품 라이선스는 여러 장치에서 사용할 수 있습니다.

다음 방법 중 하나를 사용하여 사용자에게 할당된 라이선스를 다른 장치에서 사용할 수 있도록 할 수 있습니다.

새 장치에서 동일한 사용자가 있는 Arm 개발 도구에 대한 제품 라이선스를 활성화합니다.

캐시된 Arm 제품 라이선스 세부 정보는 .armlm 디렉터리에 저장됩니다.

Arm 개발 도구를 사용하는 다른 장치는 다음과 같은 방법으로 캐시된 라이선스를 사용할 수 있습니다.

.armlm 디렉터리를 새 장치의 로컬 디렉터리에 복사합니다.

.armlm 디렉터리를 네트워크 디렉터리에 복사합니다. 새 장치에서 ARMLM_CACHED_LICENSES_LOCATION 환경 변수를 네트워크 드라이브의 .armlm 위치로

설정합니다.



Keil MDK Professional UBL은 이전 Keil tool도 사용할 수 있습니다.

MDK 5.37 이전 버전, PK51, PK166, DK251

OS에 맞는 Arm License Management를 다운로드합니다.

다운로드한 압축 파일을 압축 해제합니다.

bin폴더로 이동 후, armlm-gui.exe를 실행합니다.

CLS/LLS에 맞게 UBL을 활성화 합니다(본 매뉴얼 참고)

armlm-gui.exe를 닫습니다.

bin 폴더에서 마우스 우 클릭을 통해 터미널(cmd/powershell)을 엽니다.

아래 명령을 입력하면 해당 Tool에 맞게 LIC가 터미널에 출력됩니다.

armlm genlic

생성된 LIC를 Keil에 등록합니다.

Keil MDK Professional UBL로 PK51 사용하는 방법
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https://developer.arm.com/documentation/102516/1-3/Activate-and-deactivate-your-product-license/Activate-a-license-without-installing-tools?lang=en


GUI 수동 연장 방법

Arm License Management Utility에서 활성화된 라이선스를 클릭하고 Reactivate를 클릭합니다.

CMD 수동 연장 방법

armlm 실행 파일이 있는 bin 폴더로 이동합니다.

관리자 권한으로 터미널을 열고 아래 명령을 입력합니다.

armlm reactivate --product <활성화 코드>

사용자가 UBL 생명주기를 수동으로 연장하는 방법
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사용자가 UBL을 수동으로 비활성화하는 방법
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GUI 수동 연장 방법

Arm License Management Utility에서 활성화된 라이선스를 클릭하고 Deactivate를 클릭합니다.

CMD 수동 연장 방법

armlm 실행 파일이 있는 bin 폴더로 이동합니다.

관리자 권한으로 터미널을 열고 아래 명령을 입력합니다.

armlm deactivate --product <활성화 코드>



기존 대비 UBL의 장점이 무엇인가요?

빌드/테스트 속도 향상, 초기 도입 비용 대폭 감소, 유연성 증가 등이 있습니다.

우리 개발환경에서 UBL이 몇 Copy가 필요한지 어떻게 계산하나요?

일반적으로 개발자의 수입니다.

기존 FlexNet 환경으로 사용 중이라면 lmtools 로그를 공유해주시면 사용 통계를 제공해드립니다.

UBL은 기존 Floating 라이선스와 호환성이 있나요?

호환되지 않으며 서로 다르게 운용해야 합니다.

출장 등의 이유로 회사 밖에서 사용할 수 있나요?

CLS의 경우 인터넷이 연결되어 있다면 언제든지 사용 가능합니다.

LLS의 경우 서버와 연결이 가능하거나 생명주기가 유효하다면 사용 가능합니다.

서버 관리 비용이 증가하나요?

CLS의 경우 서버 시작, 프로비저닝, 유지 관리할 필요가 없습니다.

LLS는 기존 Floating/FlexNet에 비해 데이터 In/Out이 현저히 줄어듭니다.

클라우드 또는 가상환경에서 사용할 수 있나요?

클라우드 호스팅 개발환경은 주요 Use case이며 UBL에 내장된 기능입니다.

자주 묻는 질문
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